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About Rig Manager
Rig Manager™ is a editor and librarian software designed to help manage your personal amp collection for 

the PROFILER™

This is what Rig Manager can do among many other things:

	• Backup all Rigs and Performances in your PROFILER

	• Open old backup files and access all the Rigs and Performances inside

	• Supply you with thousands of free Rigs, both from our cloud based Rig Exchange and also from own free 
offerings (Rig Packs).

	• Sort and search Rigs conveniently

	• Tag your Rigs to get a perfect overview

	• Manager and create Performances

	• Convert Impulse Response files to PROFILER Cabinets
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Getting Started on Windows
“Rig Manager 32-Bit.msi” and “Rig Manager 64-Bit.msi” install all necessary applications and drivers along 

with this documentation. Please note that there are individual installers for 32- and 64-bit Windows ver-

sions. Once the installation has completed, you can find the application in the Start menu.

All you need to do now is connect your PROFILER with the PC using a standard USB cable.

Once you launch Rig Manager, it will connect with your PROFILER and start syncing. Depending on how 

many Rigs you have installed, this might take a while. The good news, however, is that subsequent launch-

es will be much quicker.

	♦ Setting up

Next, please fill in your e-mail address (user name) and password for the Kemper website. Now, Rig Man-

ager can connect to Rig Exchange™, providing you with thousands of free, additional Rigs. 

	✔ “Test Login Credentials” verifies your account info, it does not verify if your PROFILER is connected right.

USB TYPE-A USB TYPE-B
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 Rig Manager needs a reasonably new revision of the Kemper operating system and will prompt you to up-

date your amp if required.
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Getting Started on a macOS
“Kemper Rig Manager.pkg ” installs all necessary applications and drivers along with this documentation. 

Once the installation has completed, you can find the application “Rig Manager” in the in the Applications 

folder.

All you need to do now is connect your PROFILER with the Mac using a standard USB cable.

Once you launch Rig Manager, it will connect with your PROFILER and start syncing. Depending on how 

many Rigs you have installed, this might take a while. The good news, however, is that subsequent launch-

es will be much quicker.

	♦ Setting up

Next, please fill in your e-mail address (user name) and password for the Kemper website. Now, Rig Man-

ager can connect to Rig Exchange, providing you with thousands of free, additional Rigs. 

	✔ “Test Login Credentials” verifies your account info, it does not verify if your PROFILER is connected right.

USB TYPE-A USB TYPE-B
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 Rig Manager needs a reasonably new revision of the Kemper operating system and will prompt you to up-

date your amp if required.
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Overview

The main window is divided into four sections. 1 The first section, located on the left, is called “Locations”. 

A location represents your PROFILER, what’s on your drive and also Rig Exchange. Select a location and 

the list in the middle of the application will show its content. The 2 List is the second section. Many opera-

tions take place in there. To select a Rig, click the corresponding row. To load and edit a Rig (play it with 

your PROFILER), double-click it. While you’re at it, take a look at the 3 Inspector on the right. It shows 

a table containing loads of additional info about the selected Rig. The information can also be edited by 

double-clicking on a cell. 4 Is the Editor Section. 5 is a search field to narrow down the list if required. The 

last section is the 6 footer bar. Information about the items selected within the List and also information 

on the Editor do show here.
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Manage all your Rigs

Housekeeping

To see the entire content of your amp, and nothing else, select the location “PROFILER”. Editing tags, re-

naming and deleting rigs in the main list will instantly be reflected in your PROFILER. 

	✔ Please note that a deleted rig will be gone, Rig Manager does not have a trash folder. A good alternative to 

deleting rigs is to move them out of the PROFILER to your local drive.

Prepare a collection

Assuming you would like to prepare a collection of your favorite Rigs, here’s a step-by-step guide:

	• Click on “All Rigs” at the top of the Locations list on the left side. You will see all Rigs, independently of 
their location, in one big list. If you choose to search only a specific place, for instance the Rig Exchange, 
select “Rig Exchange” instead.

	• Next, narrow down the list by searching through it using keywords, or sort it by clicking on a column head-
er such as “Amp name” or “Date”. You can add more columns by right-clicking on the header bar.

	• Once you’re happy with your pre-selection, you can start auditioning Rigs. Please note, this only works if a 
PROFILER is connected. Double-clicking on a Rig, sends the Rig straight into the PROFILER where you can 
play it.

	✔ Rigs of interest can be made Favorites by ticking favorite in the Inspector. A favorite is symbolized by a 

green star icon.

	✔ One other option is to drag a Rig you like to another location. This will copy the Rig. To store it permanent-

ly in your PROFILER, drag it onto the “PROFILER” location on the left.
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Another typical task is to make a backup

Assuming your would like to backup all Rigs in your PROFILER, this is what you would have to do:

	• Select your PROFILER in Locations on the left

	• Select all Rigs in the main List

	• Drag them all over to your Local Library in Locations

	✔ Alternatively, create a folder on your desktop using the Finder, and drag all the Rigs onto this folder. This 

works both ways, you can also drag Rigs from a folder into the Rig Manager.

Move and copy things in between different locations

For certain tasks it can be handy to open multiple windows, and drag-and-drop items between them. 

Open a second window by opening the context menu for a Location

	• A simple drag will create a copy of an item

	• SHIFT-drag will move an item instead of creating a copy
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Search options

Most Rigs available are fully tagged with useful information such as details on the cabinet and microphone 

used among many other things. The search field in the upper right corner allows you to search broadly by 

taking all locations into account as well as narrowing down your search by selecting specific tags only.

	• To browse for specific gain settings: Type “+++” in the search field and all rigs with a Gain from 3.0 - 3.9 

will be shown.

	• To Browse for specific rig ratings: Type “***” in the search field and all rigs with a rating of three stars will 

be displayed.

	✔
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Tagging

The PROFILER features a sophisticated tagging system. One of Rig Manager’s many purposes is to as-

sist you when tagging your own Profiles and Rigs. In order to tag a Rig, you need to select it in the main 

List; the Inspector on the Right will be populated with the tags already set. Since tags can be used to filter 

Rigs, it is advisable to spend some time creating meaningful tags; this will make finding the Rig again a lot 

easier.

You can tag multiple Rigs at the same time. Select a few and take a look at the Inspector. The Tags which 

are not identical to all the selected Rigs will show “-- Multiple Values --”. Note that you can still edit the val-

ues, but be aware of the consequences of altering many Rigs at the same time.

	✔ “TAB” moves the cursor to the next tag

Use folders to structure your library

In some cases, it can help to organize your Rigs in a folder structure instead of sorely relying on tagging 

methods. A right-click on “Local Library” allows you to create a sub folder which can hold as many rigs as 

needed. Please note that a sub folder can only exist in this place and not in the PROFILER itself.

Imports and Exports

Single Rig files (*.krig, kperformance and *.kpreset) can be imported and exported using the correspond-

ing options within the file menu. Users who don’t have access to their amp, or would like to send files at-

tached to e-mails, might find this option useful.

You might already have created a number of backups with your PROFILER. Drag a backup file onto the 

application window, and Rig Manager will mount the backup as a location. Note that you cannot write new 

files to a backup. For most situations, it is advisable to mount, backup, and then copy all the files to anoth-

er place - for instance your Local Library - this way you can easily access and modify files from a backup.
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Rig Exchange

At the time of writing, our cloud based server offers you over 15000 free Rigs from fellow users from all 

over the globe. We would like to take the opportunity to thank all participants and also invite you to help 

our user base by uploading your own creations. To browse through all free Rigs, simply choose the loca-

tion “Rig Exchange” on the left of Rig Manager’s main window.

To learn more about Rig Exchange, go here: https://www.kemper-amps.com/rx 

Rig Packs

Those bundles of free Rigs are usually by an Artist or theme based, “Bass Rigs” for instance. Packs can be 

browsed by choosing the location “Rig Packs”. Rig Manager automatically downloads the latest offerings 

for you.

http://www.kemper-amps.com/rx
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The Rig Editor
The editor is an extension of the main Rig Manager window which you can find at the lower End. The ex-

tension itself has an upper strip which represents the effect signal flow and a lower portion which hosts 

the actual editor area. 

The Signal Flow

	✔ You can re-arrange the effect by dragging those onto different effect slots. To make a copy instead, hold 

K (option) on macOS and C on Windows. Effect presets can be dropped onto slots from the usual 

locations such as your Local Effects library. To store an effect preset, simply drag it from the Signal Flow 

onto the Local Library or any other suitable place. A double click toggles if an effect is activated or not.

The Editor Area

Select an effect slot by single-clicking on the icon. This will make the editor controls adjust to what’s avail-

able for this particular effect.

You can change the value of a parameter with the mouse by grabbing the control and dragging the mouse. 

Hold the : (shift) key for micro-adjustments. Alternatively, change the parameter in question on your 

PROFILER and the editor will follow.

Located on the left side are several menus to enable/disable an effect, select the actual effect algorithm 

or lock it against change. You will be familiar with all this since you know it from your PROFILER hardware 

already.
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The Status Bar

Smart Save options and a lot of information in context to what you click and edit are located at this lower 

end of the Editor Area. The multiple Save buttons offer various options to save the edited Rig.

	• “Store” becomes active once you’ve adjusted something in a Rig. It’s there to remind you to save your 
work when required.

	• “Store to PROFILER” and “Store to Local Library” copy the Rig to one of the two locations. From this point 
onwards, you will work on the copied Rig instead. If an option is not available, the Rig is already located 
there.

	• “Duplicate” creates a copy in the same location. Note that Rig Manager, in a second step will go to the new 
duplicate and will not automatically store the original Rig. If you like to keep the last state of the Rig you 
duplicate, you need to store it first.

	• “Store in Performance” is available when a Rig is a part of a performances.

To the left of the store options, the Rig’s name or Effect’s name is displayed. On the outer left corner, you 

can find further info such as the parameter values.

Edit Morphs

To make a parameter morph, simply hold B (Command) on macOS and C on Windows while chang-

ing its value. As you can see, this creates an increasing span between two colored dots. The orange dot 

represents the toe position whereas the blue one shows the heel position. To change the toe value, release 

the option key. To reverse the position of the dots and therefore reverse how the parameter will morph, 

drag in the opposite direction. 

Keyboard Shortcuts

The following Editor specific key commands are to your disposal:
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Shortcut Meaning

a Amplifier Page

c Cabinet Page

i Input Page

o Output Page

1 - 8 FX Slot #1 - 1#8

m Trigger Morph Ramp (to simulate morphing)

A complete list of keyboard shortcuts can be found here: “Keyboard Shortcuts” on page 29

Context Menu Options

Effect Slots, as well as Parameters, have self-explanatory context menus. It’s always worth to check those 

out, they contain many shortcuts for you.

Handling Impulse Responses

To convert an Impulse Response audio file, simply drag it onto the Cab icon in the Signal Flow or onto a 

Preset library location for multi-file conversions. Several different bit rates, as well as file formats, are sup-

ported. If in doubt, use WAVE or AIF files with either 16 or 24 bits.

Alternatively, select a Preset location and choose File >Import Impulse Response from the menu.
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Handling Performances
Rig Manager enables you to preview, collect and arrange PROFILER Performances and their respected 

Rigs.

Right click / C-click inside a column in list view opens a popup menu with the option to create a new 

Performance. This Performance will be empty at first and only the first slot will be enabled. As you can see, 

Performances can also be edited using an inspector on the right side of the window.

There are several ways to populate the empty slots with Rigs of your choice. We found, the preferred way 

to do so is to open a second windows with your Rigs in focus and drag those onto the empty Performance 

slots. To open a second window, right click on a location of your choice and select “Open in new window”.
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Once you will have filled up your new Performance, it is time to tweak it to your liking. Double clicking the 

slot’s name to edit it, drag the slot around to shuffle the order.

Managing Performances

A Performance in PROFILER has a fixed location, in difference to the Rigs or Performances located on your 

hard drive, which are stored in a pool. As a result, managing Performances can require you to act slightly 

different depending on if you work in your Local Library or within the memory of your PROFILER.

Performances in the location PROFILER

This list consists of 125 entries. An “empty” performance is called “New Performance” and deleting it will 

initialize it instead. It reflects the memory content of your PROFILER.

Windows version: You can drag and drop in between rows. This way, you move and insert a Performance 

elsewhere. Holding C while dragging will result in a copy instead of moving an item.

Mac version: You can drag and drop in between rows. This way, you move and insert a Performance else-

where. Holding K creates a copy instead of moving an item.

Performances in the Local Library

In there, handling performances is identical to the way you handle Rigs in your Local Library. Arranging 

happens though filtering and sorting rows. Sub folders can be created for a specific type of overview.
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The Tools Menu

Backup and restore Rig Manager’s entire content

Those backups contain the entire content of your Rig Manager including all Local Libraries and excluding 

the content of your PROFILER. The backups are cross-platform compatible, in other words you can use 

them to transfer your Library from Macs to PCs and vice versa. 

Use this backup to migrate your data from one computer to another.

	✔ Note, that this is a different backup to the one you can create in PROFILER and put on an USB stick.

Revert OS to Release version

This option comes to life once you allow Rig Manager to install beta versions on your PROFILER. It enables 

you to safely roll back to the last release version of PROFILER OS.

Export Tags to CSV file

Use this export function to tranfer Rigs information and Tags to a text writer application.
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Tips and Tricks

	♦ Tagging multiple rigs at once

Especially when housekeeping you might want to select multiple rigs and tag them all at once. 

	♦ Customize List view

Right click on the Tab bar to choose which tags are visible. Drag the tabs to re-order the list view.
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Preferences

	♦ Automatically check for Software Updates

Enable this option to allow Rig Manager to periodically check for newer software version. This includes 

both updates to Rig Manager and also to PROFILER OS.

Beta releases contain new features and bug fixes but also may contain new issues we haven’t addressed so 

far. We do not recommend you to use beta versions in a Production environment. If you decide to roll back 

to the latest release version you can do so by using the roll back option in the Tools menu of Rig Manager.

If you use a Public Beta version, we would like to encourage you to visit our Forum and join the testing 

community. To report an issue, log into your user account on the Kemper website here:
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Beta Test Portal https://www.kemper-amps.com/betatest

	♦ Show Tooltips

When enabled, hovering over a rig with the mouse pointer will show more details on the rig. Hovering over 

the name of a tag will show an explanatory text.

	♦ Adjust brightness of the Editor section

Change the brightness of the Editor section only.

https://www.kemper-amps.com/betatest
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Keyboard Shortcuts MacOS

Shortcut Meaning

Á Select next item (rig or location for instance)

Ø Select previous item

¸ Preview next Rig/Performance (only works, when you already preview an item)

fl Preview previous Rig/Performance (only works, when you already preview an item)

UPO Send the selected Rig/Performance to your PROFILER and store it there

BPM Deletes the selected rigs instantly

BPe Export Performance / Rig

UPBPn New Performance

UPf Make Favorite

UP0 0 to 5 rate a Rig 0 to 5 stars

BPi Import Rigs/Performances

BPUPi Import Impulse Response and make Preset

BPb Open Backup

BPÁ Move Performance or Slot Down (Performance mode only)

BPØ Move Performance or Slot up (Performance mode only)

BPF Find

BP, Open Preferences

BP? Open Rig Manager Help
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Shortcut Meaning

a Amplifier Page

c Cabinet Page

i Input Page

o Output Page

1 - 8 FX Slot #1 - 1#8

m Trigger Morph Ramp (to simulate morphing)

t Toggle On/Off
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Keyboard Shortcuts Windows

Shortcut Meaning

Ctrl-I Import Rigs/Performances/Presets

Ctrl-Shift-I Import Impulse Response

Ctrl-E Export Rigs/Performances/Presets

Ctrl-Shift-N Create new Performance

Ctrl-Shift-B Open PROFILER Backup

Ctrl-P Open Preferences

Ctrl-F Find

Ctrl-N Open new window

Ctrl-F1  Open Rig Manager Manual

Ctrl-Del Delete Delete Folder/Rigs/Performances/Preset

F2 Rename Folder

Ctrl-Enter Load Rig/Performance into the editor and preview

Shift-Enter Send the selected Rig/Performance to your PROFILER and store it there

Shift-F Make Favorite

Shift-0 to Shift-5 Rate Rig

Ctrl-Up Move Slot/Performance up

Ctrl-Down Move Slot/Performance down

Home Go to first entry in list



KEYBOARD SHORTCUTS WINDOWS 33

Shortcut Meaning

End Go to last entry in list

Left Preview previous Rig/Performance

Right Preview next Rig/Performance

a Amplifier Page

c Cabinet Page

i Input Page

o Output Page

1 - 8 FX Slot #1 - 1#8

m Trigger Morph Ramp (to simulate morphing)

t Toggle On/Off

www.kemper-amps.com 
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